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Safety precautions

This product complies with the requirements of the following European Community Directives: 2014/30/EU
(Electromagnetic Compatibility)) as amended by 2014/32/EU (CE-Marking).

The following safety precautions must be observed before operation. Damages resulting from failure to observe
these safety precautions are exempt from any legal claims whatever:

Comply with the warning labels and other info on the equipment.

Do not subject the equipment to direct sunlight or extreme temperatures, humidity or dampness.

Do not subject the equipment to shocks or strong vibrations.

Do not operate the equipment near strong magnetic fields (motors, transformers etc.).

Keep hot soldering irons or guns away from the equipment.

Allow the equipment to stabilize at room temperature before taking up measurement (important for exact

measurements).

Replace the battery as soon as the battery indicator “ ” appears. With a low battery, the meter might produce

false reading.

Fetch out the battery when the meter will not be used for long period.

Periodically wipe the cabinet with a damp cloth and mid detergent. Do not use abrasives or solvents.

Do not store the meter in a place of explosive, inflammable substances.

Do not modify the meter in any way.

Opening the equipment and service- and repair work must only be performed by qualified service personnel.

Measuring instruments don’t belong to children hands.

Cleaning the cabinet 



Clean only with a damp, soft cloth and a commercially available mild householder cleanser. Ensure that no water
gets inside the equipment to prevent possible shorts and damage to the equipment.

Introduction

This series of data loggers for temperature, humidity (P 5185); DC voltage from 0 to 30V (P 5186) and
temperature measurements via type K probe (P 5187) convinces by its long recording time exact recording date
and time, with 32 000 readings in internal memory and then can be accessed via USB.

Technical features

Data logger with internal memory up to 32.000 readings

Multi-line LCD display with warning LEDs

measuring rate from 10 seconds up to 12 hours

Replaceable 1/2 AA 3.6V lithium battery

recording time up to 2 years possible

Panel description

P 5185:



1 Empty

2 Function switch to start and stop of the logging process

3 LCD-Display

4 Status LED

5 LED-Display if battery is low

6 USB-Port

7 External sensor for measuring Temperature & Humidity (RH%) (Measuring head: approx. 6 mm diamet
er)

P 5186:



1 Terminals for voltage measurement

2 Function switch to start and stop of the logging process

3 LCD-Display

4 Status LED

5 LED-Display if battery is low

6 USB-Port

P 5187:



1 Input for type-K temperature sensor

2 Function switch to start and stop of the logging process

3 LCD-Display

4 Status LED

5 LED-Display if battery is low

6 USB-Port

Symbols in the display

1. Indicates the unit of the displayed value.

2. Shows the actual measurement value.

3. “-symbol means that a part of the recorded measurements exceed the upper limit.

4. “-symbol means that a part of the recorded measurements exceed the lower limit value.

5. The display changes depending on state of charge from to . An empty battery should be replaced immediately.

6. LOG icon is displayed when the logging mode is active and readings are recorded.

7. It is stated the channel whose current readings are displayed.



NOTE: The LCD does not work below -10 °C.
For more information about the software you can use the Help menu within the software.

Installation

Insert the battery
To take the data logger into operation, the 3.6V lithium battery must be inserted at first.

Note:
Be sure to align this connection to the housing part, if you do it on again.

Software Installation
To take the data logger into operation, the PC software must be installed from the CD first.



Please insert the software CD into the CD / DVD drive of your PC. If the program does not run automatically,
double click the “setup.exe” file and install it in any folder on your hard drive.

Follow the onscreen instructions to complete the installation. It appears a new symbol “Datalogger Graph” on the
desktop.

Please note that you must install the USB drivers after installing the software in order to use the Data Logger
software.

Installing the USB driver

After completing the software installation, make sure that the software CD is inserted into your CD / DVD-ROM
drive of your PC.
Double-click on the file “USBXpressInstaller.exe” in the folder “Driver” on the CD to begin the installation.
Follow the onscreen instructions to complete the installation of the USB driver. You can now plug the data logger
into a free USB port of your PC.
A moment later, your computer will display a message that the driver for the data loggers were fully installed and
the device can be used now.
Now, you have successfully installed the required software and USB drivers for your data logger.

Note: The device can be used only in conjunction with the Software and is not recognized as an external hard
disk.

Operation

Settings before use
To use the data logger, proceed as follows:

1. Make sure the battery is inserted correctly.

2. Plug the data logger into a free USB port of your PC, on which the datalogger Graph software and drivers are

installed.

3. Double-click on the icon “Datalogger Graph” on your Windows desktop to start the datalogger Graph software.

In the upper left side of the software window the “Start” button is located. Click it to open the dialog box “Device

Data Logger”.

4. Select the current data logger. You can check the firmware version, status, etc. of the selected data logger.

5. Click the tab “Setup” to display the “Data Logger Setup”. Follow the onscreen instructions to set up your data

logger and adjust settings. In the “General” tab, you can rename your data logger and set the measuring rate.

In the “Channel Settings” tab, you can set the upper / lower limits and alarm settings. In the “Start and Stop

Method” tab you can specify how the data logger should start or stop recording. The data logger is preset when

you first start the software to the default values.

6. Click the “Finish” button. The data logger will start according to your settings.

7. Remove the data logger from the USB port of your PC.



Evaluating the data logger 
Connect the data logger to your PC and start the “data logger graph” software.

1. Insert the data logger into a free USB port of your PC, on which the datalogger Graph software and drivers are

installed.

2. Double-click on the icon “Datalogger Graph” on your Windows desktop to start the datalogger Graph software.

In the upper left side of the software window the “Start” button is located.

3. Select the current datalogger. You can check the firmware version, status, etc. of the selected data logger.

4. Click on the “Download” button in the dialog “DATALOGGER DEVICE”. You can follow the onscreen

instructions to download and save the data to your PC.

5. If the download is complete, the message “Download finished” (Download complete) will be displayed and you

can display the “Open” button which downloaded data graphically.

Evaluation of the measurement data with a graph 

1. Double-click on the icon “Datalogger Graph” on your Windows desktop to start the datalogger Graph software.

2. By using the menu “File � Open” you can open a data log file (*.dlg, *.mdlg) and display the graph.

3. Zoom (Zoom In):

a. Click the mouse inside the graph area and drag a box to zoom in the desired range.

b. Zoom Out (Zoom Out):

Click “Undo Last” or “Undo All” in the toolbar to display the last graph or the original diagram.

4. Pan: 

Press and hold the middle mouse button. Now you can use the graph to move freely / position and move the

graph area.



5. Zoom and Pan Method: 

Auto: Zoom and Pan in any direction.

Horizontal: Zoom and pan in horizontal direction only.

Vertical: Zoom and pan in the vertical direction only.

6. Mark of data points: 

Click with the right mouse button on a point of the curve diagram. A pop-up menu will appear. Now click on

“Label Data Points” to mark the selected item.

7. Graph Settings: 

Click the right mouse button on the chart area and a popup menu is displayed. Click on “Graph Settings” to

open the dialog box “Graph Settings”. Here you can specify color, font, size and line unit for the chart.

Export File
The software saves and opens files of type *.dlg or *.mdlg as default.
With “Save as …” from the “File” menu, you can choose between different file types: *.dlg; *.mdlg; *.txt; *.csv; *.xls;
*.bmp and *.jpg.

Print
To print the graphs, statistics and data table, click the printer icon on the standard toolbar or select “Print” from the
“File” pull-down menu.
Users can also click on the “File-> Print and Export options” to choose the printed contents of the following dialog.

No LED flashes

Data logger is in idle state, the battery is exhausted or there is no battery installed.

LED flashes green every 10 s

The data logger is currently in recording mode.
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Both LEDs flash green every 10s

The data logger will start the logging by Date – Time, which is predefined by the user or it
should be recalled that the user presses the button to start.

Both LEDs flash green every 60s

The data logger has completed the preset logging by the user and stopped the recording
.

LED flashes red every 10s

The data logger is currently in the recording mode.

The Alarm Mode (High / Low / or both) on a channel is enabled.

Both LEDs flash red every 60s

The data logger has completed the preset logging by the user and stopped.

Alarm (high, low or both) on at least one channel is enabled. Note: This condition occurs
only if the alarm Hold is enabled.

LED flashes yellow every 60s
Display for low battery voltage. The logging continues, however the battery should be ch
ecked and replaced as soon as possible.

LED flashes yellow all 1s
Indicates that an USB connection exists.

Alternately one LED flashes yellow and the other green
Battery is installed and the device can be used.

Alternately one LED flashes yellow and the other red
Battery is installed but the unit cannot start.

1. Battery status can be checked via the Data Logger device dialog in the datalogger Graph software. Even if the

battery is empty, the recorded data do not lost.

2. Start and stop method can be set via the Data Logger Setup dialog box in the datalogger Graph software.

3. Red alarm LED for each channel and green LED status indicator can be turned off to save battery on the Data
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Logger Setup dialog box in the datalogger Graph Software.

4. If alarm Hold is activated, the red LED will flash once the readings have exceeded the preset alarm limit and

even if the readings return to normal range. This ensures that you always know when the alarm limit has been

exceeded.

Function key 

The datalogger has only one function key. The function depends on the mode in which the datalogger is located
at the time:
If you select via the Data Logger Setup dialog box in the datalogger Graph software to start logging by pressing a
button, you can press and hold down the function key (until the green LED lights up) start logging.

If you select from the Data Logger Setup dialog box in the datalogger Graph software that you want to overwrite
existing data when the data logger has stopped logging due to depleted memory, you can press and hold down
the function key
(until the green LED lights) stop logging.

If you have set on the Data Logger Setup dialog box in the datalogger Graph software the LED alarm set (upper
and lower limits) and activated and thus the red LED flashes at increasing or decreasing of the set limits.

You can press through and pressed hold the function key (to the red LED), the LED reset alarm.

To obtain proper measurements 
Before starting a recording, you should check the battery capacity.
Note to obtain the use of the data logger the specified ambient temperatures and humidity levels correct
measurement results.

Technical Data

General: 

Memory 64k Bytes (32.000 Measurement Values)

Sample-Rate adjustable from 10 seconds to 12 hours

Measurement Start Immediately; Start by pressing button; Start by pre-set of Time/
Date

Measurement Stop Measuring stops, if memory is full Measuring stops, when pres
et measurement point has been reached



LED-Display

Red and green LED

Status display of the data logger: Includes the delay of the start
of the measurement, display with recording of measured values
(logging), alarm and measurement completed

 Using the software, these two LEDs can be turned off to save t
he battery voltage.

 Yellow LED

Display low battery status

Length of the sensor Length of the measuring line: 3 meters

Protection class IP 20

Battery ½ AA 3.6V Lithium-Battery 1200mAh

Battery Life Up to 2 years depending on the setting of the measuring rate a
nd the LED display

Operating temperature 20°C, ± 5°C

Dimensions (WxHxD) 38 × 122 × 22 mm

Weight 60g

Relative Humidity (RH%) 

Range Resolution Accuracy

0 … 100% 0,1% RH ±3,0% RH

Air -Temperature 



Range Resolution Accuracy

-40 …125°C 0,1°C ±0,3°C

(-40 …257°F) 0,1°F ±0,5°F

PeakTech® 5186
Voltage (DCV) 

Range Resolution Accuracy

0 … 30V DC 0,01V +/- 1,0% of rdg. + 6 digits

PeakTech® 5187
Temperature – Input Type-K 

Range Resolution Accuracy

-200 … 1300°C 0,1°C ± 0.5°C

-328 … 2372°F 0,2°F ± 0.9°F

Battery Replacement

If the -Symbol appears in the display the battery should be replaced.
Open the unit as described in section 5.1 and remove the old battery and put in a new one of the same type (3.6V
Li-battery).
Used batteries are hazardous waste and must be placed in the appropriate collection container.
If the device is not completely closed, it should not be put into operation.

Note:

1. Keep the device dry.

2. Hold the Sensors clean.

3. Keep the unit out of reach of children.

4. If the ” ” symbol appears, the battery is exhausted and should be replaced as soon as possible. If you are using

a battery, pay attention to correct polarity of the battery. If you do not need the device for an extended period,

remove the battery from the device.

Notification about the Battery Regulation

The delivery of many devices includes batteries, which for example serve to operate the remote control. There
also could be batteries or accumulators built into the device itself. In connection with the sale of these batteries or
accumulators, we are obliged under the Battery Regulations to notify our customers of the following:



Please dispose of old batteries at a council collection point or return them to a local shop at no cost.
The disposal in domestic refuse is strictly forbidden according to the Battery Regulations. You can
return used batteries obtained from us at no charge at the address on the last side in this manual or
by posting with sufficient stamps.

Contaminated batteries shall be marked with a symbol consisting of a crossed-out refuse bin and the chemical
symbol (Cd, Hg or Pb) of the heavy metal which is responsible for the classification as pollutant: „Cd“ for
cadmium, „Pb“ stands for lead and „Hg“ for mercury.

All rights, also for translation, reprinting and copy of this manual or parts are reserved.
Reproductions of all kinds (photocopy, microfilm or other) only by written permission of the publisher.
This manual is according the latest technical knowing. Technical alterations reserved. Misprints and errors are
reserved.
We herewith confirm that the unit is calibrated by the factory according to the specifications as per the technical
specifications.
We recommend to calibrate the unit again, after one year.
© PeakTech® 11/2021 Mi/Hr/Tw/Lie

PeakTech Prüf- und Messtechnik GmbH – Gerstenstieg 4 – DE-22926 Ahrensburg / Germany
+49 (0) 4102 97398-80
+49 (0) 4102 97398-99
info@peaktech.de
www.peaktech.de
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